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LICENSE FOR USE:
Shareware Trial Edition.

WARNING! THIS IS NOT FREE OR PUBLIC DOMAIN SOFTWARE. 
THIS IS A COPYRIGHTED COMMERCIALLY PUBLISHED PROGRAM.

WHAT IS SHAREWARE?
Shareware is a means of marketing Software at a reasonable price. Developers of Software use 

Shareware to distribute their products using Shareware because it provides a minimal advertising cost. 
Advertising costs money. In order to market a program on a retail basis, a developer typically needs to sell 
a minimum of 5000 copies a month. Shareware circumvents this somewhat and helps provide you the 
customer with a good value at a much lower price  than you would receive from a commercial source.

In order for shareware to work, If users are actually using  a product, they must register. Developers 
can't continue to develop and improve products if customers don't register and upgrade. Running a small 
business costs money. If you enjoy using a shareware product, either register it or tell the developer what 
they can do to provide a product that you will register. If you don't register remove the product from your 
system and don't  use it. 

Shareware is not Free or Public Domain Software. You can't expect timely upgrades and fixes from 
Free or Public Domain Software. With a Product like ASTRO, if you register, and you there are problems I 
will do everything I can to see that the product works well for you. I will provide you as much assistance as
I can. This unfortunately costs money. I can't do it without your registration.

This software is provided for Trial Purposes Only! The purpose of this is to give you the user the 
opportunity to try out ASTRO without having to buy it in order to try it.

This version allows you to use all features of this version unimpaired. You are Entitled to Use this 
Shareware Version for Up to 30 days from purchase without Obligation. You may not use this version for 
any Commercial Purpose. I will attempt to provide a minimal level of technical support to any caller who 
calls asking for help without registration.

When you register this program, I will send you the latest version of ASTRO, free of limitations and 
reminders, complete with all utilities.

Since this package is provided for trial purposes, you may copy the original .ZIP or .LZH files or 
disks you received as many times as you wish, and upload, download it to your heart's content.

This version is provided in two different versions  One shipped in .ZIP format files compatible with 
PKZIP/PKUNZIP, this version is preferred for BBSs. The other is shipped with a proprietary install 
program which works with LHA.EXE uses .LZH compressed files. These files can be decompressed using 
LHA as well. If you wish to upload the .LZH version, you should create an archive called AST271-0.LZH 
containing INSTALL.EXE, INSTALL.DAT, and INSTALL.3.

The only thing I ask is to upload or copy the entire package intact, in the original ZIP file (provided 
you got this package on a BBS) or disk form, and not change the program or any of the documentation.

Unauthorized alterations versions to this package will be considered "Pirated" or hacked. This is to 
protect you the user from receiving a damaged files that may damage your system or
disk. The disks I send you once you register this program may not be copied, except for archival or backup 
purposes only.

NOTICE: If you wish to use This program for Commercial Purposes, Please print 
out two copies of the file COMAGRE.DOC, sign and return with the registration 
form. Please contact me if you have any questions about this.

By registering you will be entitled to technical support and future upgrades at reasonable prices. If 
You are in a rush I can notify you of the password for your program till your Updated copy arrives.

_____
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Payment of $29.95 or budget registration gets you a password which will turn off the registration screens 
and disclaimer at the top of reports. It also entitles you to notification of additional products and upgrades, 
and 90 days technical support.

____
Payment of $44.95 or Lite Registration gets you a fresh copy of ASTRO Lite, complete with a set of disks 
and printed manual. The Lite version includes a 1200 Location database and additional birth information 
for a number of famous people.

____
Additional Non-Shareware versions are available. Please see the file VERSIONS.DOC for additional 
versions.

To Register, Print out the file README.WRI, VERSIONS.WRI or REGISTER.WRI.
These files have a registration form in them. Fill in an send to with a check or money order:

Christopher J. Noyes Software 
144 Union Street, Store A
Brooklyn, NY 11231

Or FAX to (718) 625-6766 if using a credit card.

Or E-Mail to compuserve 71570,3055 or CJNoyesSW on AOL or cjnoyessw@aol.com from the internet if 
you are using a credit card.

Or call (718) 625-2262 if you are using a credit card.

By registering you will be entitled to technical support and future upgrades at reasonable prices. If 
You are in a rush I can notify you of the password for your program till your Updated  copy arrives. You 
may distribute the Shareware version of ASTRO as long as you do not charge more than $5.00 per disk. A 
lot of hard work went into ASTRO. In order to continue improving ASTRO and providing extensions to it, 
you must register it. Without your support, I cannot afford to justify the expense and energy necessary, if 
you will not register and support this product.

Thanks in Advance,

 Christopher J. Noyes
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WARRANTY
If I cannot to resolve any problems you have with ASTRO I will refund your 

money. You must  return this manual and all disks and this manual that I shipped you 
when you registered.

While I have made every attempt to assure that ASTRO works properly, I am not  
responsible for any damage, loss of profit, or other losses caused by ASTRO. 

SUPPORT
For technical support on ASTRO:
* Contact me on Compuserve Mail using the ID 71570,3055.
*  Contact me on America On-Line using the ID CJNoyesSW.
*  Contact me on the Internet using the E-Mail address cjnoyessw@aol.com or 

71570.3055@compuserve.com.
*  Contact me on ILINK bulletin board systems using the name Chris Noyes.
*  Contact me on the Christopher J. Noyes Software Bulletin board system at
(718) 625-0411. Set Your Modem for 2400 baud, No Parity, 8 Data Bits, 1 Stop bit.
*  Fax Me at (718) 625-2262
*  Call me at (718) 625-2262 between the hours of 10:30 A.M. and 8:30 P.M. (EST), 

any day. If I am not available, please leave a message, I will call you back as soon 
as I can.

*  Contact me by Mail at the address below.
Christopher J. Noyes Software
144 Union Street, Store A
Brooklyn, NY 11231.

This program is produced by a member of the Association of Shareware Professionals 
(ASP). ASP wants to make sure that the shareware principle works for you. If you are 
unable to resolve a shareware-related problem with an ASP member by contacting the 
member directly, ASP may be able to help. The ASP Ombudsman can help you resolve a 
dispute or problem with an ASP member, but does not provide technical support for 
members' products.  Please write to the ASP Ombudsman at 545 Grover Road, 
Muskegon, MI USA 49442-9427, Fax 616-788-2765, or send a CompuServe message via
CompuServe Mail to ASP Ombudsman 70007,3536.
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NEW TO ASTROLOGY?

To get the most out of this program you will need some understanding of astrology. 
ASTRO does provide some help in this area via the Astrology Help found in the Help 
menu, and the "Astrological Glossary" in the back of this manual. You will be more able 
to make use of this program if you do some background reading. I suggest the following 
reading material:

Instant Astrology. By Mort Gale. Published by Warner Books, New York, 1980.
Compendium of Astrology. By Rose Lineman and Jan Popelka. Published by Para Research, West Chester

PA, 1984.
Parker's Astrology: The Essential Guide To Using Astrology in Your Daily Life. By Derek and Julia 

Parker. Published by Dorling Kindersley. First American Edition 1991.
The New A To Z Horoscope Maker and Delineator. By Llewellyn George. Revised and Expanded, 

Revised and Edited by Marylee Bytheriver. Published by Llewellyn Publications, St. Paul, 
Minnesota, Current version Copyright 1981.

These are a few more books that may be good for users with any degree of experience with astrology or 
with ASTRO.

The Houses: Power Places of the Horoscope. Edited by Joan McEvers. Published by Llewellyn 
Publications, St. Paul, Minnesota, Copyright 1989.

Planets in Combination. By Lynne Burmyn. Published by ACS Publications, San Diego CA, Copyright 
1985.

Progressions Directions and Rectification, or the Great Guessing Game...What Time Where You 
Born? By Zipporah Pottenger Dobyns. Published by T.I.A. Publications, Copyright 1975.

The Rising Sign--Your Astrological Mask. By Jeanne Avery. A Dolphin Book, Published by Doubleday, 
New York, Copyright 1982.

Astrological Assistance. By Saul P. Larner. Published By Prentice Hall, Englewood Cliffs, NJ, Copyright 
1972.

The International Atlas, Second Edtion, World latitude, Longitudes and Time Changes. Compiled and
Programmed by Thomas G. Shanks. Published by ACS Publications, San Diego, CA, Copyright 
1985, 1988.

The American Atlas, Revised, US Latitudes and Longitudes. Time Changes and Time Zones. 
Compiled and Programmed by Thomas G. Shanks. Published by ACS Publications, San Diego, 
CA, Copyright 1978, 1987
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INTRODUCTION TO ASTRO:

Background.
ASTRO was conceived of in 1985, when I was programming on a Commodore 128 computer. I started 
working on ASTRO out of curiosity mostly, and soon got deeply  involved. I soon ported it over to the IBM
PC when I discovered I couldn't get ASTRO to do what I wanted on the Commodore. The Commodore 128
had limited capabilities and limited tools available to develop programs.

The original Version of ASTRO that appeared on the IBM PC in early 1987 was good at some 
things, particularly its simplicity, speed, and ease of use. It did have some problems though. It particularly 
had problems for advanced astrologers and those people who were very new to computers. The original 
program also had problems, primarily in lack of accuracy and problems due to not following common 
astrological standards. It was good though for people who were really only casually interested  in astrology.

I got so many reactions from more advanced astrologers that I decided to rebuild ASTRO from 
scratch and resolve most of their problems. This version of ASTRO is for all intensive purposes a brand 
new program. The only things that I kept were the text that ASTRO generated, the Astrology Help text, and 
some modes used.

This release is the Fifth major release of ASTRO. It breaks major ground and makes many 
improvements over earlier versions. I have introduced many new features and ironed out many other fine 
spots.

Why Use ASTRO?
ASTRO, The Program for Astrological Analysis, or ASTRO for short, is a powerful computer 

program. 
Where many astrological computer programs produce accurate results, they mostly produce just the 

numbers and the facts. They tell you very little about yourself or others. To find the information, you have 
to do much research into the 'delineation' or interpretation of the numbers and the signs. 

ASTRO is different. I designed ASTRO to produce a textual type of output, consisting of the 
numbers, text interpreting the results into significant terms. ASTRO also provides a graphics cartwheel 
printout as well that helps in understanding the individual's chart.

ASTRO is excellent for the  new astrologer who really doesn't understand all the details in 
interpretation, and is seeking to learn more: more about others, more about themselves. ASTRO provides 
an excellent learning aid in the Astrology Help. I am not suggesting though that ASTRO can totally replace 
an excellent astrologer's delineation of a highly accurate chart. It can, though, provide an excellent starting 
point. 

ASTRO is also excellent for the experienced astrologer. It can provide charts that rival those 
provided by hand or other computer systems.

Basic Capabilities.
ASTRO has an easy-to-use intuitive user interface. It is easy to use, and is much more powerful.
ASTRO has several built in databases. One for people's birth dates, times and places. The other is a 

database of locations, giving all the necessary data for approximately 1000 U.S. and Canadian cities and 
approximately 200 foreign cities.

An optional database adds 32,000 additional U.S. locations. A complete database of U.K. locations is
available from a 3rd party as an option.

This version of ASTRO uses highly accurate routines to generate the planet positions, house cusps, 
and aspects. Planetary positions are accurate to within 5 minutes in arc. Typically the positions are within 
one minute of accuracy in many places as compared to competitive programs. 

ASTRO can generate the following chart types:
*  Natal charts.  *  Compatibility charts.  
*  Transits charts.
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ASTRO supports all the major house cusp systems including:
*  Equal house.  *  Placidus.  
*  Koch.  *  Companus.
*  Regiomontanus. *  M-house.
*  Morinus.

ASTRO also provides the following: 
*  Decans. *  Midheaven.
*  Moon's nodes. *  Part of Fortune. 
*  Vertex. *  East-point. 

ASTRO also provides other important calculations and determinations. ASTRO also provides birth 
rectification, by which you can figure out basic houses, even if you don't know a person's exact time of 
birth.

Graphic cartwheels can be copied to the clipboard .
With ASTRO you can convert your reports to word processing files that you can import into your 

favorite word processor. File formats supported include:
*  Plain ASCII text file. *  "Smart" or formatted ASCII.
*  WordStarTM 3.x. *  WordStarTM 4.x. 
*  WordPerfectTM 4.x. *  WordPerfectTM 5.x.
*  XYWriteTM *  Microsoft WordTM RTF.
* Lotus AMI ProTM

 Word processing formats retain all formatting information.
ASTRO creates reports that use bold and underscore capabilities of your printer, and screen, along 

with a numeric only report format, in case you only want the numbers.
This program produces all files directly to the disk in a special compressed format. 
The names of the files generated to the disk are kept in a file list stored on disk and in memory. You 

can select from many different charts that you may have calculated and kept on disk. You can mark these 
charts with comments when compiling, that can aid you in figuring out which chart to look at, print, 
convert, or view as a graphics-cartwheel.

If you have a math coprocessor chip ( 80387 80487SX, 80486DX and compatibles), ASTRO 
supports this chip and produces a faster chart, and faster graphics drawing. If you do not have the math 
coprocessor, ASTRO will emulate the coprocessor.

New Capabilities.
This version supports many capabilities that the other programs don't.
Groups of files can be deleted, converted, printed, etc. by tagging files. Tagged files are marked with

a check mark.
You can also almost totally customize the way that your reports are printed using report tables that 

you can easily create and modify.
Printing of reports is improved, along with support for various printing capabilities.
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SYSTEM REQUIREMENTS TO RUN ASTRO FOR WINDOWS:

Though ASTRO is a flexible system and can be run on many different type of system 
setups, it does have some requirements for hardware.

Computer and DOS.
ASTRO for Windows requires a computer with at least an Intel 80386SX processor (80386SX 80386DX,  
80486SX, or 80486DX). SLC, DLC and DX2 processors are also supported. The computer must have a 
minimum of 4 megabytes (MB) of memory, a hard disk, MS-DOSTM or PC-DOSTM version 5.0 or greater 
and Microsoft WindowsTM 3.1 or greater.

Disk Setup.
This version of ASTRO requires a hard disk. ASTRO For Windows requires about 2 megabytes of free disk
space plus space for your compiled reports. The 33,000 location database requires approximately 4 
megabytes of free disk space. The text modification capability requires about 2 megabytes free disk space. 
Your compiled charts and reports can be compiled to a floppy disk.

Video.
ASTRO for Windows requires at least a VGA graphics adapters. ASTRO for Windows supports all graphics
adapters which support Windows and provide at least 480 x 640 pixel 16 colors. 

Printer.
ASTRO directly supports all printers that Microsoft Windows supports. graphics printing requires a printer 
with graphics capability supported buy Windows. Most 9-pin, 24-pin, ink-jet and laser printers are 
compatible with Windows. Either use a driver supplied with your printer or use one that is compatible 
supplied with Windows.
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CONVENTIONS USED IN THIS MANUAL:

This section describes the conventions that are used in this manual.

ALL CAPS System command, or command line  to type at the
DOS command line.

A: Disk drive letter, or other device.
A:\<Directory Name>\<File>Path name.
.. Previous directory
. Current directory
\<Directory Name>\<File> Path name, beginning at root directory, or start of 

current disk drive.
FILENAME.EXT A file name can consist of up to eight letters, a '.' and 

a three letter extension.
'Key Name' A key on the keyboard to press.
{ALT} Hold down the ALT key on your keyboard.
{CNTL} Hold down the CNTL or  Control key on your keyboard.
{SHIFT} Hold down the Shift key on your keyboard.
{Fn} A function key for example {F1} means press the F1 key at

the top or left of your keyboard.
{ALT}+'A' Hold down the ALT key, and press the 'A' key on 

your keyboard.
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INSTALLING ASTRO FOR WINDOWS:

Most people will probably can run the installation program and go. If you wish to, you 
can easily change the setup using the setup function found under the option menu.

IMPORTANT
Before you start using ASTRO, I suggest that you make backup copies in case you harm 
or destroy the original master diskettes. This way you can reinstall the program if you 
damage the originals.

You Must Run the Install Program! 
To Install ASTRO For Windows, insert the "ASTRO For Windows Disk 1" disk into your drive. From 
Program Manager choose "Run...", from the File menu, type A:SETUP if you want to install from your A: 
drive or type B:SETUP if you want to install from your B: drive.

Keeping Saved Files.
If you want to keep reports you have generated, you can store them off-line on floppy disks. You can copy 
them back to your user disk or directory when you need them. Use the Scan for Files Not in List menu item
to read the files into the list once you copy them. You can also erase the file NASTFILE.LST from your 
user disk or directory and ASTRO will create a new one.

In this version, you can also save the birth data to a disk file and erase the compiled charts at the end of 
your session. When you wish to recompile a chart, all you have to do is load the birth data file and 
recompile the chart. ASTRO saves all the data in the data dialog boxes to one file. These files are much 
smaller than the files that the charts get compiled to. 
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STARTING UP ASTRO FOR WINDOWS:

You are ready to start using ASTRO For Windows. 

Starting ASTRO.
To Start ASTRO from the Program Manager, click on the ASTRO for Windows Program group and restore 
it if it is not open. Then click on the ASTRO for Windows icon.

Finding Startup Files.
ASTRO  attempts to read the list of compiled chart files on disk into memory. This file is a list of all the 
files created the last session. ASTRO uses the name NASTFILE.LST.

 ASTRO stores this in the user directory.  If this file can't be found, the program assumes it erased 
the file, or it never existed before and ASTRO scans the directory for ASTRO reports and ASTRO graphic 
files and puts these into the file list and saves it using the file name NASTFILE.LST.

ASTRO then reads the file ASTRODAT.HIS (if it exists). This is the History file, data that was in the
Data dialog boxes at the time that ASTRO quit last. Then ASTRO reads the file ASTRODAT.DEF (if it 
exists). This is the default data, and the program loads the file every time it starts. If you want certain chart 
information loaded every time ASTRO starts up save that information to the file ASTRODAT.DEF, using 
the Save  or Save As menu commands in the File menu.
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COMMAND LINE OPTIONS:

These are the command line options that ASTRO allows. You can start ASTRO with any 
one command line options.  You must separate the name ASTRO from your options with 
a space. Options begin with either a '/' or a '-', and you can type these in capital letters or 
non capital letters.

To Start ASTRO From within Windows
Click on the ASTRO for Windows Icon in the ASTRO For Windows Group Box.

To View A Text file:
C:\ASTROW\ASTROW -VT NATAL0.OUT
C:\ASTROW\ASTROW -VT C:\FILES\NATAL0.OUT
NATAL.OUT is located in the ASTRO directory or the USER directory if you have one.

To View A Graphics file:
C:\ASTROW\ASTROW -VG NATAL0.GRA
C:\ASTROW\ASTROW -VG C:\FILES\NATAL0.GRA
NATAL.GRA is located in the ASTRO directory or the USER directory if you have one.

To Print A Text file:
C:\ASTROW\ASTROW -PT NATAL0.OUT
C:\ASTROW\ASTROW -PT C:\FILES\NATAL0.OUT
NATAL.OUT is located in the ASTRO directory or the USER directory if you have one.

To View A Graphics file:
C:\ASTROW\ASTROW -PG NATAL0.GRA
C:\ASTROW\ASTROW -PG C:\FILES\NATAL0.GRA
NATAL.GRA is located in the ASTRO directory or the USER directory if you have one.
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QUICK REFERENCE GUIDE

This is a quick step-by-step guide on how to use ASTRO for Windows for most of it's 
basic features.

How to create a Birth (Natal) Chart.
1. Choose the Data menu. 
2. Choose the menu choice "Birth Info". 
3. Fill in the information on the dialog box, using the location or birth database as applicable. See 

below for information. When finished, click on the "OK"  button to complete.
4. Choose the menu choice "Birth Rectification". If you know the person's birth, check the first 

question check box, then click on the "OK" button. 
5. If you don't know the birth time, complete the dialog box, depending on how you want deal with the 

chart.
The rest of this dialog box is applicable only if you don't know the birth time.

Move over to the Compile menu. Choose a chart. For example, choose "Birth Signs, Houses & 
Aspects." Fill in the information about the chart.

6. Move to the Compile menu. Choose a chart. For example, choose "Birth Signs, Houses & Aspects."
7.  Fill in the information about the chart.
8. The chart is compiled.

How to create a Compatibility or Composite Chart.
1. Choose the Data menu. 
2. Choose the menu choice "Birth Info". 
3. Fill in the information on the dialog box about the first person, using the location or birth database as

applicable. See below for information. When finished,  click on the "OK"  button to complete the 
dialog box.

4. Choose the menu choice "Birth Rectification". If you know the first person's birth, check the check 
box, then click on the "OK" button. 

5. If you don't know the birth time, fill in the rest of the information on this dialog box, depending on 
how you want to deal with the chart.

6. Repeat the first five steps using the Compatibility Information dialog box and the Compatibility 
Birth Rectification dialog box for the second person.

7. Move  to the Compile Menu.
8. Choose "Compatibility", or choose "Composite".
9.  Fill in the information relating to the chart.
10. The chart is compiled.

How to create Transits Charts.
Use a transit chart to compare the planet locations during a given point of time, compared to an individual's

birth. A transit chart is also referred to as a day-to-day chart.
1. Choose the Data menu. 
2. Choose the menu choice "Birth Info". 
3. Fill in the information on the dialog box, using the location or birth database as applicable. See 

below for information. When finished, click on the "OK" button  to complete.
4. Choose the menu choice "Birth Rectification". If you know the person's birth time, check the first 

check box, then click on the "OK" button. 
5. If you don't know the birth time fill in the rest of the information on this dialog box.
6. Choose the menu choice "Transits Info". 
7. Fill in the information about the first date you wish to analyze. Rough location and time of day help 

to localize the chart and make it more exact. For this example we enter Monday's date and our 
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present location.
8. Choose the menu choice "Transits Data". 
9. Fill in the number of charts to do. For this example we want to do seven charts, one for each day of 

this week. 
10. Choose the starting planet to include. I suggest selecting the Sun. Choose the ending planet to 

include, since the outer planets don't move very often, don't include them. I suggest using Venus or 
Mars as the ending planet. 

11. Enter the period between charts. In this example, we would enter zero months and one day, which 
will do seven charts, each one-day apart.

12. Move over to the Compile menu.
13. Choose "Transits." Fill in the information about the chart.

How to Get a Person's Information from the database.
When in the Birth Info, Compatibility Info or Transits Info dialog box, and on the "Name" field, click on 
the  combo box (down arrow)  button at the right of the field, select the name you want from the list and 
click to select it.

How to Add a Person's Birth Information to the database.
1. When in the Birth Info, Compatibility Info.
2. Fill in the information in the birth dialog box. 
3. Click on the "Birth DB Menu" button at the bottom of the birth dialog box. 
4. A menu will appear. Select "Add a New Birth". 
5. Click on the "Birth DB Menu" button at the bottom of the birth dialog box. 
6. A menu will appear. Select "Make Popups". 

How to Get a Location From the Location Database.
1. When in the Birth Info, Compatibility Info, Transits Info dialog box, move to the country field. 
2. Click on the down arrow icon at the right of the field, select the country you want from the list and 

click to select it. 
3. Move to the state field. 
4. Click on the down arrow button at the right of the field, select the country you want from the list and

click to select a state or region (all the states or regions on file within the country are shown).
5. Move to the location field. 
6. Click on the down arrow icon at the right of the field, select the country you want from the list and 

click to select a location (all the locations within the state or region within the selected country are 
shown). 

7. All the information about the country will be filled in.

How to Add Location Information to the Database.
1. When in the Birth Info, Compatibility Info, Transits Info dialog box, or Relocation Data dialog box, 

fill in the information for the location. 
2. Click on the "Location DB Menu" button at the bottom of the birth dialog box.
3. A menu will appear. 
4. Select "Add a New Location". 
5. Once complete, go to the Utilities menu and pick "Make Popups" (for locations or all files).

How to Get Information From an Earlier Compiled Chart.
1. Select a file from the "ASTRO Reports" file list.
2. Go to the Utilities menu. 
3. Choose "Read File Into Data". 
3. Select the file you want to read.
4. The information will be put back into the dialog box that the information came from originally.
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How to Copy Birth Info to Compatibility Birth Info or Compatibility to Birth Info.
While in the Birth Info or Compatibility Info dialog box, click on the "Birth DB Menu" button and select 
"Copy" from the menu. Go to the dialog box you wish to copy the data to, click on the "Birth DB Menu" 
button and select "Paste" from the menu.

How to Copy the Location Data to Another Dialog Box.
While in the Birth Info, Compatibility Info, Transits info or Relocation Data dialog box, click on the 
"Location DB Menu" button and select "Copy" from the menu. Go to the dialog box you wish to copy the 
data to, click on the "Location DB Menu" button and select "Paste" from the menu.
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THE FILE LIST VIEWER

This is a list of all the files that you have created. There are two file lists, one of graphic 
files, and one of text report files.

KEYS:
PAGEUP Go up one screen.
PAGE DOWN Go down one screen
DOWN Move the selection bar down one line.
UP Move the selection bar up one line.
HOME Go to the beginning of file list.
END Go to the end of file list.
ENTER View currently selected file.
or double click If selected file is a text report file,  the text file viewer is started. If 
with mouse.    the selected file is a graphics file the graphics file Viewer is started.

Same as File menu View.
DELETE Erase a file.  Same as Files menu KILL.
CTRL+INS Copy file to clipboard. Same as Files menu KILL.
SPACE BAR Select a file for multiple file operation.  All files which are checked
or mouse click are selected.
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VIEWING GRAPHIC FILES

Use the Graphics menu to change the ways the information is displayed on
the screen. Go to the View menu to Zoom In, Zoom Out or have the wheel scaled to
the size of the window.

KEYS:
PAGEUP Go up one screen.
PAGE DOWN Go down one Screen
DOWN Go down one line.
UP Go up one line.
HOME Go to the left of  image.
END Go to the right edge of the image.
CTRL+HOME Go to the top image.
CTRL+END Go to the bottom of the image.
LEFT Scroll left.
RIGHT Scroll right.
CTRL+P Print. Same as Files menu command Print
The Following keyboard combinations have equivalents in the Graphics and View menus.
Transit chart operations
[ Go to Previous transit chart
] Go to Next transit chart.
= Go back to First transit chart.
View operations:
Num + Zoom In. Same as View menu command Zoom In.
Num - Zoom Out. Same as View menu command Zoom Out.
Num * Zoom In. Same as View menu command Fit Window.
You can copy the image to the clipboard by Selecting the Edit menu and the 
Copy menu item.

Graphics Menu Commands.

Show Sign Names.
This menu command turns on or off the display of sign names in the graphics screen around the outside. If 
glyphs are being used, then glyphs will be used, otherwise the names will be used.

Show House Numbers.
This menu command turns on or off the display of house numbers in the graphics screen around the outside
or in the middle.

Show House Degrees.
This menu command turns on or off the display of house degrees in the graphics screen around the outside 
of the cartwheel.
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Show Aspects.
This menu command turns on or off the display of aspect lines in the graphics screen in the middle of the 
wheel. Aspect lines are only shown in natal or relocated charts, where the charts are compiled with aspects.

Use Glyphs.
This menu command turns on or off the use of glyphs in the graphics cartwheel.

Show Sign Lines.
This menu command turns on or off the display of sign lines in the graphics cartwheel.

Use Inner House Cusps.
This menu command selects which house cusps to display when displaying compatibility, transits, or 
progressions cartwheels.

Tick Wheel Options

Sign Tick Wheel.
This menu command turns on of off the display of sign tick wheels. A sign tick wheel is an outer circle 
showing the signs, and uses the glyphs.

Decan Tick Wheel.
This menu command turns on of off the display of decan tick 2heels. A decan tick wheel is an outer circle, 
but inside the sign tick wheel, showing the decans of the signs.

Degree Tick Wheel.
This menu command turns on of off the display of degree tick wheels. A degree tick wheel is an outer 
circle, but inside the decan or sign tick wheel, showing the degrees.

House Numbers Outside.
This menu command selects whether to display the House Cusp Numbers outside the wheel or at the center
of the wheel.

Plot Classic.
This menu command selects whether to display the planets and sign degrees horizontally plotted 
approximately where they should be or display them on angles into the wheel.

Show Planet Degrees.
This menu command turns on or off the display of planet degrees which will be plotted below the glyph, 
otherwise they are not plotted and the glyphs are plotted larger.

Use Next Chart.
When displaying transits charts, this menu command displays the next transit chart. If there are no more 
charts, the first is displayed.

Use Previous Chart.
When displaying transits charts, this menu command displays the previous transit chart. If the first chart is 
being displayed, the last is displayed.

Page 20



ASTRO For Windows Shareware Manual

Use First Chart.
When displaying transits charts, this menu command displays the first transit chart.

View Menu Commands

Zoom In.
When the graphics screen is not in fit window mode, this menu command zooms the graphics screen in and
enlarges the graphics screen.

Zoom Out.
When the graphics screen is not in fit window mode, this menu command zooms the graphics screen out 
and reduces the graphics screen.

Fit Window.
This menu command turns on of off fit window mode. In fit window mode, the graphics screen is scaled to 
fit the window.
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VIEWING TEXT REPORTS

Use this to view the text report files that ASTRO produces. If you wish to you can 
customize the colors and fonts that are used in the viewer. You can convert this report to 
text, print it. 

KEYS:
PAGEUP Go up one screen.
PAGE DOWN Go down one screen
DOWN Go down one line.
UP Go up one line.
HOME Go to the beginning of report.
END Go to the end of report.
LEFT Move cursor  left.
RIGHT Move cursor  right.
CTRL+P Print. Same as Files menu command Print.
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FILES MENU

Open
Birth Data

This menu item opens an existing birth data file. You are prompted for the name of a file to open.

NOTE: Don't attempt to load any file that you did not save with Files/ Save Birth Data. You may also load 
the file ASTRODAT.DEF or the file ASTRODAT.HIS.

Save
Birth Data.
This menu item saves the birth data in the dialog boxes to a file. This prompts you for a file name.

NOTE: If you want to have a set of data loaded into your system every time that ASTRO starts up, save it 
as ASTRODAT.DEF. You should save this to your user disk and directory, so don't use a path or disk. 
ASTRO saves the chart you were working on last in to the history file ASTRODAT .HIS, also in the user 
disk and directory.

Save As
Birth Data.
This menu item saves the birth data in the dialog boxes to a file. This prompts you for a file name.

Export
This menu item exports the file in the file list you have selected. If you have selected a graphics file, a 
graphics file is exported. If you have selected a text file, a text file is exported. 

If you are in a graphics file viewer or in a text file viewer, the file that you are viewing is printed.
If you have checked multiple files and have the option in the Options menu "Print/Convert All 

Checked" checked this menu item converts all the files you selected.
This menu item prompts you for specific data about the file and prompts you for the file to write to.
To convert files to text, you can setup different file formats. If you are using Microsoft Word for 

Windows, use RTF in which you can setup the desired fonts  using the setup styles button.
You can convert a file to either ASCII, WordStarTM 3.x or 4.x, WordPerfectTM 4.x or 5.x, 

XYWriteTM, or, Microsoft WordTM RTF (Rich Text) format. You can also  save ASCII and XYWrite files 
without any soft line breaks. You can rebreak the file easier when you read it into your word processor, 
since soft and hard line breaks are the same. These files are saved with all attributes intact.

NOTE: When you save files saved in WordPerfect format, document default information such as printer, 
default font, or styles will not be saved to the file. This Information is written to the file when you save it 
from WordPerfect. 

Files saved in XYWrite format have no printer, font, or setup information encoded in them. You may
need to read and Insert a file into your default document to use it in XYWrite.  

The files saved using this function are entirely unformatted without page breaks or headers. This file 
is, though, wrapped to whatever text width you wish, and has a left margin, making it easier for your word 
processing program to work with.

If you are converting to ASCII you can select between two different approaches. One is a plain 
ASCII, another is "smart" pseudo formatted ASCII. Most people prefer the plain ASCII. Plain ASCII has no
formatting information. In "smart ASCII", the text Attributes are translated into strings that you can change 
from the "Word Processing Conversion dialog box".
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View
This menu item opens the viewer screen that corresponds to the type of the file in the file list you have 
selected.

Pressing {ENTER} in the file list screen or double clicking the mouse on the selected item has the 
same effect as selecting this menu item.

Kill.
Selecting this menu item kills the file from the file list and deletes the file from your disk. The above dialog
box asks you if you want to delete the files.

If you have checked multiple files and have the option in the Options menu "Print/Convert All 
Checked" checked, this menu item kills all the files you selected.

If you are killing multiple file and uncheck "Continue To Ask" and press the "OK" button, all the 
files will be deleted. If you press the "No" or "Cancel" button, no files will be killed.

If you are killing multiple file and leave "Continue To Ask" checked, you will be prompted 
for each file.

Print.
This menu item prints the file in the file list you have selected. If you have selected a graphics file, a 
graphics file is printed. If you have selected a text file a text file is printed. 

If you are in a graphics file viewer or in a text file viewer, the file that you are viewing is printed.
If you have checked multiple files and have the option in the Options menu "Print/Convert All 

Checked" checked this menu item prints all the files you selected.
This menu item prompts you for specific data and options about the file.
You can select to print any range of pages

Page Setup
Graphics
This menu item sets up the margins for printing of graphics and text reports.

Print Setup
Graphics
This menu item lets you pick the printer that you use for printing graphics cartwheels. This can be a 
different printer or entirely different setup from the text.

Pressing the "Setup" button, opens your printer driver's setup dialog box which varies with printers.
Pressing "Options" button,  opens the Graphics Options dialog box which lets you customize the 

graphics printout.
Pressing the "Colors" button applies only to color printers and allows you to change the colors used. 

Clicking on the "Fonts" button, allows you to change the font used for the graphics cartwheels.

Text
This menu item lets you pick the printer that you use for printing text reports. This can be a different printer
or entirely different setup from the graphics.

Pressing "Options" button,  opens the Report Print dialog box which lets you customize the text 
printout.

Clicking on the "Styles" button, allows you to change the fonts for text printouts.
Each button you press corresponds to a different font you can customize.

Exit
Exits ASTRO for Windows. You will be prompted to see if you wish to save the file list.
If you click on the Yes button, the file list is saved. If you click on "No", the file list and all the files in the 
list are deleted. If you click on "Cancel" the file list is not saved, but not files are deleted.
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EDIT MENU

When you are in the file list viewer, comment file editor, text viewer or the graphic 
viewer, you can use the Edit menu to copy items and data to the clipboard or find text or 
items.

Undo.
If you were in the file list viewer and chose cut or paste, the Undo menu item undoes the previous action.

Cut.
In the file list viewer, you can delete a file from the file list or just delete the reference to it in this screen by
selecting this menu item. You will be asked if you want to kill this file. If you do choose to delete the file, 
you will not be able to Undo this action.

If you choose not to kill this file, the file is eliminated from this list and the information on it is copied to 
the clipboard. 
Copy

In the graphics viewer, this menu item copies the graphic image to the clipboard.
In the file list viewer, this menu item copies the reference to the file to the clipboard. You can use 

this to copy files to a user file list viewer.

Paste
In the file list viewer, this menu item pastes the reference to the file to the clipboard. You can use 

this to copy files to a user file list viewer.

Delete
In the file list viewer, you can delete a file from the file list or just delete the reference to it in this screen by
selecting this menu item. You will be asked if you want to kill this file.  If you do choose to delete the file, 
you will not be able to Undo this action. 
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ENTERING DATA:

You will use the "Data" menu choices  to enter information on the dates in question and 
other data for transits, progressions, returns, etc. Most of the questions asked and 
information you will need to enter are really self-explanatory. You can get information for
each field by pressing {F1} or clicking the mouse or pressing on the Help button. This is 
how to use these dialog boxes:

Important Information.
Should you have trouble at any time with ASTRO, there are several things that you should remember. The 
following table describes some useful information. 
{F1} Get Help in any menu or data dialog box. 
{ESC} or {ESCAPE} Back out of any dialog box or series of screens to the main 

    menu. Also cancel any entry choice. 
{DOWN}, {TAB}, {ENTER} Move Down through fields.
{UP},  {SHIFT}+{TAB} Move Up through fields

Database Fields.
In the "Info" type of field such as "Birth Info", several fields have databases attached. The first field 
(Person's Name) has a database of birth dates attached to that field. 

Through that database, you can save the entire contents of this dialog box, by name, for whomever 
you wish to enter. The birth location (Country, State or Region, and Location) fields also have a database 
attached to them. This database has only the location data such as longitude, latitude, and time zone. You 
can instantly make use of these databases by using the combo box control while in the Name, Country, 
State, or Location fields.

In the case of the location fields, ASTRO will only read the data from the database once you have 
used the combo box on the location field itself. The location fields are "hierarchical". This means that first 
you select a country. Then ASTRO shows you all the states or regions available from that country. After 
you select that state or region, ASTRO displays all the locations in that region.
NOTE: In order for a name or location to be in the combo box, it must be first added to the database, using 
the database menus. You must also run the "Make Popups" choices from the "Utility" menu to update the 
popup list. In the Birth Info dialog box, you can run "Make Popups" for the birth database from the birth 
database menu.

If an entry has not been added to the popup list, you can still make use of that record in the database.
To do this,  enter the name in the proper field and call the proper database menu. When you receive 
ASTRO, default popup files have already been created for you.

Finding Information in the Database.
The easiest way to find information in the database is with the combo box controls in the dialog boxes. You
can select from any available choices with these controls.

When the database finds information, it ignores case. You can type the name ALL CAPS or all lower
case or anything in between and you will have no trouble finding the data you want. 

You can also find partial data in the database by entering just part of it. If you were looking for a 
person's birth data and didn't quite remember the spelling of their last name, you could enter what you 
remembered of the last name. Suppose you had "John MacNeil" in your database and wanted to find his 
data you could enter "John", "John M", or "John Mac" and might find the information. This depends on 
how many other entries are in the database that are similar.

NOTE: These databases do not allow more than one identical entry with the same key field.
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Database Menus.
The databases have menus that you can use to get information, add records, update records, and delete 
records. There is a database menu for the birth database and there is a menu for the location database. 

NOTE: These databases have no connection to the file list that files which you compile turn up in. In order 
for information to be added to these databases,  you must add them to the databases and run the 
"Make Popups" utility.

To get to the birth database, click on the "Birth DB Menu" button. This database uses the person's 
name field as the key to the database. ASTRO uses this field to find the information you want.

If you indicate in the Birth Rectification dialog box,  you don't know the birth time, ASTRO saves 
the birth rectification information to the database as well. You can get to the appropriate rectification dialog
box, by selecting the "Birth Rectification" button at the bottom of the dialog box.

To get to the location database,  press on the "Location DB Menu" button. This database uses a 
combined key made up of the country, state and location fields. You will also notice at the bottom of the 
dialog box a button marked "Location DB Menu". Pressing  this button will select the database as well.

NOTE: Serious users will want to consult a  reference such as The American Atlas or The International 
Atlas published by ACS Publications of San Diego, CA, for exact birth location and applicable time zone 
data.

Birth Info.
Use this dialog box to enter the main birth data needed for doing a birth or Natal horoscope. Enter the data 
on this dialog box that gives the person's name, sex, birth date and time, place of birth and geographic 
latitude and longitude as well as time zone and adjustment.

This field has two powerful databases attached to the Name, Country, State or Region, and Location 
fields. If you click on the down arrow key at the right side of the Name, Country, State, or Location fields, 
you will call up a list of available choices in the database. If you wish to add information to the databases, 
fill in the information on the dialog box. Then click on the "Birth DB Menu" button for the birth database 
menu or click on the "Location DB Menu" button for the location database menu. 

This will bring up a menu. You can use these menus to add, delete and replace information in the 
databases. In order to update the lists that you see when you access them, you need to run "Make Pop-ups" 
in the Utilities menu. 

If you are adding to the Birth Database, you can find "Make Popups" for the birth database brought 
up by clicking the "Birth DB Menu" button.

You can clear this dialog box so you can begin with a blank dialog box by clicking the "Birth DB 
Menu" button and choose the "Clear" menu choice.

It is important to know as much information as possible about the person that you are going to 
analyze. You need to know birth time, date and place of birth. You also need to know the prevailing time 
zones being used at the time.

NOTE: Beware entering times around Noon and Midnight! Serious users will want to consult a reference 
such as The American Atlas or The International Atlas. These books are published by ACS Publications of 
San Diego, CA. These books contain exact birth location and applicable time zone data.

Use the Time Zone field to set the proper time zone for the person in question. Try to be as certain as
possible. This is crucial and some locations differ from one year to another. In some locations, time zones 
change between  town and county lines. If you don't know the time zone but do know the offset from GMT 
select "Other".

Use the Special Code field to set the proper special time code field. Try to be certain as daylight time
changes from year to year, and is different between towns, counties and states. If you don't know this zone 
but you know  the GMT offset, choose "Other".

You can't alter the GMT offset unless Time Zone and Special Code fields are set to "Other".
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If you did not select "Other" in the Time Zone and Special Code fields, ASTRO will fill in the GMT 
field for you. You won't be able to override this field unless you had set the Time Zone or Special Code 
fields to "Other". The adjustment for War Time, Daylight Saving Time, etc. is added to the basic GMT 
offset. Locations West of Greenwich  have positive GMT offsets, East, negative GMT offsets.
NOTE: Enter only the normal clock offset from GMT, such as Eastern Standard time is five hours from 
GMT. ASTRO makes the minor fine adjustments to GMT for you 

Compatibility Info.
Use this dialog box to enter the data for your partner. The compatibility operation uses the birth info dialog 
box as well as this dialog box to get the information needed to do your compatibility chart. Enter the data 
on this dialog box to indicate the person's name, sex, birth date and time, place and geographic latitude of 
birth (of the partner) and longitude. You also need the time zone and adjustment. It is important to know as 
much information as possible about the couple you are going to analyze. You need to know birth time, date 
and place of birth as well as the prevailing time zones being used at the time. See the Birth Info dialog box 
for more information.

You can clear this dialog box so you can begin with a blank dialog box by clicking the "Birth DB 
Menu" button and choose the "Clear" menu choice.

Transits Info.
Transit charts compare the planet positions for a series of future dates to your birth planet positions, and tell
you about the events at hand.

Use this dialog box to enter the starting date and location for your transit computation. This 
operation uses your birth info and this dialog box to do the transits along with the Transits Data dialog box. 
Enter the data on this dialog box that shows place, date and time, place and geographic latitude and 
longitude, where you anticipate being, as well as time zone and adjustment. The information entered into 
this dialog box does not need to be as exact as for the above dialog boxes.

You can clear the location section of this dialog box by clicking on the "Location DB Menu" and 
selecting "Clear".

See the Birth Info dialog box for more information on this screen.

NOTE: This dialog box indicates a starting point for a series of transits. ASTRO calculates transits as a 
series of charts, a certain period apart. 

Transits Data.
This dialog box is used with the Transits Info dialog box and the Birth Info dialog box to do transit charts. 
This dialog box allows the program to calculate a series of transit charts at one time for a specific period of 
time and a specific interval period. This will allow ASTRO to work with only a specific range of planets.

If you are doing transits one day apart, you will want to narrow your planet selection to Sun - Mars. 
If you are doing transits one week apart, you will want your planet range to be Sun - Mars. You will want to
more or less ignore the Moon as the moon makes significant changes every day. The outer planets change 
houses and  transiting aspects much more slowly.

Birth Rectification.
Use this dialog box if you do not know the exact birth time of the person you are using for primary birth 
data. Enter what you do know, or select how to calculate the chart to get the best results, even though you 
don't have the exact information. If  you know the exact birth time, you don't need this chart, so check the 
first check box and exit the dialog box by clicking the "OK" button.

If you don't know the exact birth time, you have several different choices. You can choose "Trial and
Error". This means you try a given time and see how it fits the individual. Then you try it again till you get 
the result you want. 

You can choose "Solar Chart" that sets your Ascendant and first house cusp to be the same as your 
sun sign. 
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You can choose "Flat Chart" which sets your Ascendant and first house cusp to be zero degrees of 
Aries. You can also try "Sunrise Birth time", and enter the best guess of the appropriate sunrise time. This is
similar to "Trial and Error". This frequently works since many people are born near sunrise.
NOTE: If you are using Flat Chart or Solar Chart, you should use 12:00 AM (Noon) for the Trial Birth 
time.

ASTRO supports a powerful rectification option. If you can figure out accurately the subject's 
Ascendant, Med. Coeli, Descendant or any house cusp, fill in the blanks and ASTRO will arrive at a close 
approximation of the birth time. The accuracy seems to be ±5 minutes of time. You may have to tweak the 
resulting time and retry it. You can find out the time ASTRO arrived at by looking at the trial field after 
ASTRO compiles the chart.

Compatibility Birth Rectification.
If you do not know the exact birth time of the person you are using for compatibility birth data, use this 
dialog box to enter what you do know or how to calculate the chart. This will help you get the best results 
even though you don't have the exact information. See the above material for more information.
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COMPILING CHARTS

Now that you have entered your data into the data dialog boxes you are ready to compile 
a horoscope. With exception of the first choice, (default chart) they are grouped from 
simpler to more difficult in terms of data. The later charts produce more data and more 
text (with exception of the compatibility, transits. The simpler ones may be better for a 
person with less experience in understanding astrology. With some practice and learning, 
most of the information on the charts will be useful.

Certain aspects of these charts will be based on the Options dialog boxes in the Options sub 
menu. There is an option dialog box for each of the major chart types, though most of the information will 
be adequate without changing the data in these dialog boxes.

With all these options, ASTRO asks you to fill in information to mark the file entry with for this 
chart. This information will help you identify this chart in the file listing. You may edit or change this 
information as you wish, with exception for the Type field, which is for your information only, and may not
be changed.

Once you have compiled a chart, you can change the name and comment lines as well. This 
information will help you keep track of what you have on file.

You will notice that in most of these menu items, each menu item adds one or more options to it. 
One or more of the items that were options in the previous menu item, are now standard in the next menu 
item.

Default Chart.
This menu item produces a chart that directly reflects the contents of the options data. The chart that this 
menu item produces is a complete one, and I suggest that only advanced astrologers use it. You can 
customize this menu item by changing the options dialog box. The most powerful aspect of this menu item 
is that you can practically create a custom horoscope setup as your default treatment and use it as a default 
all the time if you wish.
NOTE: For this type of chart, you need to fill in the Birth Info dialog box and the Birth Rectification 
dialog box.

Birth Signs Only.
This provides the least complex chart available. It provides only information on the individual planets 
locations in the zodiac at a given point in time. ASTRO also provides descriptive text about this 
information (you can turn this off from the options dialog box). You will also find a summary that you can 
turn off from the options dialog box as well.
NOTE: For this type of chart, you need to fill in the Birth Info dialog box and the Birth Rectification 
dialog box.

Birth Signs & Houses.
This menu item provides all the information as the previous one does, but adds the house information. This 
menu item provides the houses that each planet falls into, and descriptive text about each one. ASTRO also 
provides the coordinates of each house cusp. Also provided is information on which signs the various house
cusps fall in, and text describing what each means to you.
NOTE: For this type of chart, you need to fill in both the Birth Info dialog box and the Birth Rectification 
dialog box.

Page 30



ASTRO For Windows Shareware Manual

Birth Signs, Houses & Aspects.
Use this menu item if you want to add aspects to your chart. This will produce aspects between all major 
points and produce text about each. You can also add other miscellaneous calculations into this type of 
printout from the options dialog box. This information is on top of all the information provided by the other
two options.
NOTE: For this type of chart, you need to fill in both the Birth Info dialog box and the Birth Rectification 
dialog box.

Complete Chart.
This menu item adds the miscellaneous calculations that are optional in the last section. 
NOTE: For this type of chart, you need to fill in both the Birth Info dialog box and the Birth Rectification
dialog box.

Compatibility.
This menu item calculates a compatibility chart. ASTRO calculates the compatibility chart by comparing 
two full charts. This menu item calculates which house of one partner, the other's planets are located in, and
vice versa. ASTRO also can generate aspects for compatibility charts.

It also calculates a special summary comparing the two individuals based on the summary. As with  
all the other menu items, ASTRO produces text describing the influences of all the information described.
NOTE: For this type of chart, you need to fill in the Birth Info dialog box and the Birth Rectification 
dialog box for the main subject and Compatibility Info dialog box and Compatibility Rectification dialog 
box for the subject's  partner.

Transits.
This menu item calculates a series of transit charts. ASTRO calculates the transit charts from the 
comparison of a birth chart and a transit chart. ASTRO calculates a series of charts based on a starting date 
and a date interval between that date and  the next date. The dates and times in the Transit Info dialog box 
don't have to be as exact as the birth dialog boxes require. The time and exact latitude and longitude are 
optional, but they do help refine the data.
NOTE: For this type of chart, you need to fill in the Birth Info dialog box and the Birth Rectification 
dialog box for the subject along with the Transits Info dialog box for the first date and Transits Data dialog 
box.
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GETTING HELP

You can get help in any screen, dialog box, or menu item by pressing {F1} or clicking on 
the Help button in any dialog box. To get help on a menu item, select a menu item with 
the mouse and press {F1}.

Contents
This menu item opens the ASTRO help file and selects the contents page.

To view the help, click the mouse on the underlined topic to view that text.
While in the help system, clicking the "Contents" button above will cause this screen to be 

displayed.
Clicking "History" allow you to view topics you viewed previously.
Clicking "Search" will bring up the dialog box on the right side of this page.

Search for Help on
This menu item opens the ASTRO help file and opens the Search dialog box.

To use this dialog box, select a topic from the list, click "Show Topics", select the topic you wanted, 
press the button, "Go To".

How to Use Help
This menu item opens the help for WINHELP.EXE. the Windows Help program.

Astrology Help
Astrology Help or ASTRO-Helper  is a system of astrology topics that you can view, print or convert to 
text. 

View File.
The Astro-Helper files are reference files on disk that you can use to learn basic astrological ideas.

This button will view the file that is selected or surrounded by a dotted line.

Print Files.
This allows you to print out the Astro-Helper files to your printer. This will allow you to print copies of 
these files to give to people you create charts for. This button will print all the files that you select.

Convert Files.
This allows you to convert the Astro-Helper files to a file format you can use with your word processor. 
This will allow you to modify it or extend this file before printing copies of these files to give to people you
create charts for. This button will convert all the files that you select.
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ASTRO UTILITIES

These are functions and utilities, which you can use to help you with ASTRO. 

Read File Into Data.
This function allows you to read one of ASTRO's compiled files and get the original birth information back
into the data dialog boxes. This function brings the information back into the dialog boxes that they were 
earlier associated with. It will not  read natal birth data back into the compatibility dialog box.

Reindex Databases.
Normally when you are using ASTRO, the database indexes are continually kept up to date, and normally 
do not need to be reindexed. If the index is damaged, erased, or power is shut off to your computer or you 
reboot before leaving the Birth Info dialog boxes you may need to reindex.

 If there are duplicate entries in your database, you may see an error, but these can be ignored, as 
they won't harm your database.

Make Popups.
When you add locations to your location database or births to your birth database, you will need to use this 
function to add the new records to the popup files. You may also need to use this function if you've had to 
reindex the databases.

Merge Database Files.
This menu item allows you to merge the Database with earlier or additional databases that you have.
 This menu item inserts only the items that are not in the database and preserves your changes to the 
databases.

Clear File List Selection.
This menu item clears the check marks in the file list.  You can print, convert or kill all the files that are 
checked.

Edit File List Entry.
This menu item allows you to edit the name and comments in the file list. Select a file from the list, choose 
this menu item and you will edit the file name and comments and save it.

Rebuild File List.
If you have archived files off to other disks and now wish to use them again, this menu item will help. 
Copy your files to your user directory. Use this menu item to add the files to the file list. This menu item 
will scan for ASTRO For Windows and ASTRO DOS version 2.25+ file headers in all files in the User 
directory.

Sort File Listing.
If You have deleted files from the file list and wish to keep it around after you quit ASTRO and want it to 
be in order, use this function. This menu item sorts the file on the person's name on the chart, and places 
them in alphabetical order. Just select this menu item  to run it.
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MANAGING WINDOWS

The Windows menu lets you manage ASTRO's windows.

Arrange.
This menu command rearranges the icons for the minimized windows in ASTRO For Windows

Cascade.
This menu command cascades all the windows on the screen overlapped.

Tile.
This menu command Tiles all the windows on the screen. Tiling windows makes them all visible, but 
smaller so they all can fit on the screen at the same time.

Graphic Files
You won't see this menu command unless you have closed the "ASTRO Graphics" file list viewer. This 
menu item reopens the "ASTRO Graphics" file list viewer.

Text Reports.
You won't see this menu command unless you have closed the "ASTRO Reports" file list viewer. This 
menu item reopens the "ASTRO Reports" file list viewer.
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USING OPTIONS

Use these dialog boxes to change the setup and defaults that ASTRO uses when 
horoscopes are created. You can also use the Options menu items to change disk and 
directory choices, and other options.

You can setup options for each major type of horoscope independently. You can 
setup many different types of characteristics to customize or setup a default type of setup.

Setup.
This dialog box allows you to customize  disk and directory usages.
The Program Directory is where ASTRO itself, and the utility programs are found. These files end with 
.EXE and .DLL.

The Help Directory is where the help file and the Astro-Helper files are found. These files end with .HLP.

The Database directory is where the database files are located. These are files for the Birth and Location 
database. These files end with .DAT, .NDX and .LST.

The Data Directory is where the files that produce ASTRO's text is found. These files end 
with .TXT, .NDX, .TBL, .ORB or .DAT.  Note there is one .NDX file for every .TXT file of the same main 
name.

The User Directory is where the charts that ASTRO compiles are written. If you convert a file to a text 
file, or print to a disk file, ASTRO writes that file to the user directory unless you say otherwise. When You
save and load the birth data, you save and load from this directory unless you say otherwise.

Word Processor Conversion Setup.
This dialog box allows you to customize the way ASTRO converts files to word processing and ASCII. The
following strings don't have any effect on word processing conversion other than ASCII conversions. This 
is your default standard word processing conversion. Pick one that your favorite word processor supports. 
This will most likely either be one of the two WordStar types, one of the two WordPerfect  Choices, 
Microsoft Word, or several types of ASCII. Many Windows Based word Processors will accept .RTF type 
files as well.

If you are using ASCII, you can eliminate the soft line breaks and only have the paragraph/hard line 
breaks in the file. Using this setting, may make reformatting easier, once it gets into your word processor.

Column Width. This is the width, in inches and hundredths of an inch. You would enter a 6-1/2 inch width 
as 6.50. When converting to certain word processors, this will be based on 10 pitch or 10 characters per 
inch. Setting the column width to 6.50, the column width would be 65 columns.

NOTE: The file conversion does not concern itself with fonts. If You are using a laser printer you should 
set the font, provide settings and reformat the document once you are in your word processing program.

Left Indent. This is the width, in inches and hundredths of the left margin. You would enter a 1 inch left 
margin as 1.00. When converting to certain word processors, this will be based on 10 pitch or 10 characters 
per inch.

If you have 8-1/2" wide paper, and want a one inch margin and the text to be 6-1/2 inch wide, you 
would set these two fields as suggested here. This will give you a one inch right margin.
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Setup Styles.
If you choose this button and you are using Microsoft RTF as your conversion for Word For Windows for 
example, you can customize the fonts that are used. Each button corresponds to a font you can change.

Pseudo ASCII.
Most people will choose to use the Plain ASCII conversion. The Pseudo ASCII conversion converts the 
Bold, underline codes to specific strings that you can specify.

Start String. This string marks the start of main heads in the file.

End Head String. This string marks the end of  main heads in the file. This must turn off what the previous
command turned on.

Start Bold String. This string marks the start of bold face in the file.

End Bold String. This string marks the end of bold face in the file. This must turn off what the previous 
command turned on.

Start Underscore String. This string marks the beginning of underscore or italics.

End Underscore String. This string marks the end of underscore or italic started above function.

Graphic Options
This dialog box sets up how a default cartwheel is displayed. It also sets up how a cartwheel is printed

In these fields, check a box to turn on an option, depending on how you want these options dealt 
with. 

Show Sign Names. This turns on or off display of the sign Names around the dialog box. When glyphs are 
used, these symbols are displayed as glyphs. This is more useful for beginners, particularly if only the signs
are displayed.

This option may also not want to be used because it clutters up the dialog box when combined with 
the house cusp number and house cusp degrees.

Show House Cusp Degrees. This turns on or off display of the degrees of each house cusp. These are 
placed at each house cusp. This will be useful for most people knowledgeable about astrology.

Show House Cusp Numbers. This turns on or off display of the house numbers. These are placed midway 
between each pair of house cusp. This is useful and one of the more used options.

Show Aspect Lines. In a natal or numeric chart which was compiled using compile natal chart signs, 
houses and aspects or greater, or you compiled  default chart with aspects turned on, lines showing the 
aspects will be drawn in the middle of the dialog box. These are useful for seeing the types of aspects 
involved.

If the chart does not have any aspects, the inner aspect circle won't be drawn and no aspects will be 
drawn.

Use Glyphs. This switches between the use of the classical astrological glyphs and two and three letter 
abbreviations for the signs and planets. The glyphs display more neatly and cleanly, and once you know all 
the signs, this is the way to display charts. A novice can use the abbreviations until they are comfortable 
and switch over to the glyphs. 

Show Sign Lines. Shows or hides the display of the sign divisions on the dialog box. If a novice and you 
are only displaying the planets in the signs you will want this option.
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House Numbers Outside. Checking this option will place the House numbers outside the circles. In 
multiple wheel charts, you may want to choose this option. You may also want this option to produce charts
that match earlier charts produced by ASTRO.

Plot Classically. Checking this option causes the planets glyphs, and degrees to be plotted on a  diagonal 
the same as the degrees.

Show Planet Degrees. If you check this option the plane degrees will be plotted below the glyph, 
otherwise they are not plotted and the glyphs are plotted larger.

Tick Wheel Options.

Sign Tick Wheel. If you check this option, an outside wheel is drawn with the sign glyphs.

Decan Tick Wheel. If you check this option, an outside wheel is drawn with ticks marked for the sign 
decans, inside the sign tick wheel is shown and outside the degree tick wheel is shown. A decan is 10 
degrees.
Degree Tick Wheel. If you check this option, an outside wheel is drawn with ticks every degree depending 
on resolution. On the dialog box ticks are shown every 3 degrees.

Graphic Colors.
To use this dialog box, click on a button corresponding to the color you wish to customize. click on the 
"OK" or cancel button once finished.

Background Color. Black. This is for the general background color .

Signs Color. Green or Dashed. This is the color that the actual sign division lines are drawn in.

Houses Color. Red or Dotted. This is the color that the house division lines, are drawn in.

Planets Color. Light Grey. This is the darker color for the planets. This is not used at this time.

Circles Color. Dark Grey. This is the color used for the circles themselves.

Ascend Color. Bright Yellow or dot-dashed. This is the color used for the Ascendant line and glyph.

Bright Signs Color. Bright Green. This is the bright color for the sign division lines. This is the color that 
the sign names are printed in.

Bright Houses. Bright Red. This is the color that house numbers and house data when displayed are 
printed in.

Bright Planets. White. This is the color that the individual planet glyphs and their accompanying positions 
are displayed with.

Graphic Fonts.
The Graphic Fonts dialog box allows you to customize the fonts that are used for the graphics. Just select 
the font. The size is scaled to fit.

Click on the button corresponding to the font you wish to change.
You can in all cases customize the data font which is used for the name, data, and chart labels.
If you provide your own glyph font or you don't wish to use glyphs, you can provide a font for 

glyphs.
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Chart Options
Natal.
Use this dialog box to setup the options used by the Compile menu default birth chart selection. This 
selection also affects various aspects of other birth charts. For the most part, though, you won't have to 
change any of these options except to setup a default chart. 

You may wish to change some of these, once you have experience with ASTRO, to customize it to 
your personal preferences. These are a few of the more important options and what they mean to you.

You will have the option often when running the program to change the options on the fly, as you 
work with the compile menu.

Default Options Used.
Tropical or Sidereal Zodiac. You will probably not change this option. Most western astrologers work 
with Tropical charts. Some european or eastern astrologers use a Sidereal zodiac. In a Sidereal chart, the 
first degree of Aries corresponds to the star constellation Aries. In a Tropical chart, the first degree of Aries 
corresponds to the vernal equinox, or the first point of spring. Over time, the relationship between the star 
constellation Aries and the vernal equinox has changed.  Currently these two systems are off about 24 
degrees and it is always changing. ASTRO uses "Fagan's Ayanasma" in making this calculation.

NOTE:  This option is for experts only. Don't select the Sidereal option unless you know that you want it.

House Procedure. There are many different ways of calculating your house cusps. This option allows you 
to select one of the more popular systems. ASTRO supports Equal House, Placidus, Koch, Regiomontanus, 
Campanus, Morinus, and M-House systems. Placidus is the most popular for general purpose astrology, but
fails at high latitudes, where you may want to use another. The Equal Housesystem is the simplest, and 
often used, but may not produce accurate results. See an astrology text for more information on house 
division techniques.

Find Houses. Self explanatory. Determines if ASTRO will find house cusps.

Find Aspects. Self explanatory. Determines if ASTRO will find planetary aspects.

Find Extended Aspects. If this options is not checked then the Customize Aspect Orbs dialog box is used 
to find if a certain aspect is checked. If this options is checked, all possible aspects are considered. Using 
the Customize Aspect Orbs dialog box will probably be the first dialog box to work with if you want to 
change aspects.

Summary at End of Report. If this options is checked, a report is placed at the end of the report, 
summarizing numbers of different trends and tells you what they mean.

Miscellaneous Calcs. If this options is checked, ASTRO will calculate several different miscellaneous 
values such as decanates of signs, critical degrees, and anaretic degrees.

Extended Misc. Calcs. If this options is checked, ASTRO will display more miscellaneous information 
about a position including duad, navasma, Whether a planet is in 'fall', it's 'home' sign, decan and duad 
rulers, etc.

Vertex and East Point. If this option is checked, ASTRO will calculate the Vertex and East Point for the 
chart in question. These angles are highly theoretical in nature. No text on these is available.
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Generate Graphics Data. If this option is checked,  this option produces graphics data to run using the 
graphics cartwheel option.

For more Information about these options see the section "Compiling a Chart". You can get more 
information on each option from the help system.

Compatibility.
Use this menu item to setup the options used by the Compile menu compatibility chart selection. The 
options operate as they do in the birth options menu item.

Transits.
Use this menu item to setup the options used by the Compile menu transits chart selection. The options 
operate as they do in the birth options menu item .
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HANDLING ERRORS

There are several different levels of errors that may occur when using ASTRO. There are 
several internal errors, such as 'Screen Errors' that may occur. If these occur, you will be 
asked to report them to 'Technical Support'.

Minor Data Entry Errors.
If you make an error when entering data, the system will beep and you will see a message in the prompt 
area which will tell you about the error.

Other Errors and Warnings.
If a minor error occurs while you are using ASTRO, a box will popup on the screen and will describe it for 
you. You will be asked to press any key to continue. You will see at the top left of that box a title saying 
either 'A Note From ASTRO...' which is an extremely minor situation, 'Warning!' is a minor situation that 
you may need to be warned about, and 'Error!!' is an error situation of a more serious nature.

DOS Critical Errors.
If a serious system error occurs, you will hear a beep, and an error will be displayed at the bottom row of 
the screen. You may be asked to do one or more of the following "(I)gnore (R)etry (F)ail (A)bort".

If you see '(I)nore, you may be able to ignore the situation and continue. If you see '(R)etry', you will
be able to correct the situation and retry the operation that caused the error. If you are using DOS 3.0 or 
later you may see '(F)ail' in which case you will be able to just fail the DOS operation that caused the 
problem. However, if you see '(A)bort' and select it, ASTRO itself will end without properly shutting down.
When You see one of these, correct the situation, and make a choice. Make a choice by pressing the letter 
corresponding to the choice.

Memory Errors.
If you run out of memory there are two kinds of errors that may occur. The first is a 'Fatal' error. A fatal 
error will cause ASTRO to shut down immediately. A 'Non-Fatal' error is an error that ASTRO can recover 
from, but you will not be able to complete or repeat that operation without additional memory. This type of 
an error is displayed at the bottom of the screen such as a 'Critical Error'; in this case you will be asked to 
just press any key to continue.

Sometimes these happen because the system's memory has been fragmented, which means it has 
been broken into too many little pieces to be used. This can be solved by quitting ASTRO and restarting the
program or rebooting your system.

Screen Errors.
If something goes wrong in one of the screens that ASTRO uses, an error may occur. You will not be able 
to do anything about these errors. These errors are always fatal and should be reported to the ASTRO 
Technical Support at your earliest convenience, along with your system configuration and the situation that 
caused it to happen.

Many of these type of situations are minor. The program exits at that time to prevent a problem from
continuing to corrupt the system or DOS.

I suggest that you restart the program after that error occurs. Many of these errors happen due to 
memory limitations, and are minor. These are never due to the user.

Here are some of the more common errors that may occur and what may cause them to happen:

System Errors.
File or Directory Does Not Exist!  Check to make sure that the directories and files that this message 

concerns exist, copy them from your master diskette, or verify that the information on the setup 
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screen is accurate. Check the setup screen.
No Space Left on Drive! Delete files on that drive to make room, or switch to a new disk or drive.
Not Enough Files in CONFIG.SYS, need at least 12! Check the Installation information. This program 

requires a minimum of 12 files in the CONFIG.SYS, but 20 is suggested. You can  find this file on
your boot disk in the root or '\' directory. This file can be edited with a word processor that can 
work with ASCII files.

DOS Critical Errors.
Data Corrupted! The disk is trying to read a disk that has been corrupted, perhaps by a magnetic field or 

other damage. Recopy the disk from a master and try again.
Device or Printer Out of Paper or Not Ready! This error indicates that your printer may not be turned on,

is out of paper, or the device you are printing or writing to, such as a modem or communication 
port, is not ready to be used, and may be off-line or turned off.

Drive Not Ready! The drive door is not closed. Close it and choose retry.
Error Reading Data! Your drive is reporting errors as it reads the data. You will need to either reformat 

this disk or start with another one. In any case the data you are trying to read may not be usable.
Error Writing Data! Your drive is reporting errors as it writes the data. You will need to either reformat 

this disk or start with another one.
General Failure! There has been a general failure on this disk or device. Try it again, reboot, try again, or 

see a competent repair technician. This may suggest a bad disk, or a disk which is not formatted.
Trying To Write To Write Protected Disk! Remove the disk from the drive and remove the write protect 

tab from the disk if you are using a 5-1/4" disk, or check the write protect tab on a 3-1/2" diskette.
Unknown Drive or Unit! ASTRO is trying to write to a disk or device that does not exist. A system error 

may have clobbered a device or a part of DOS that you are trying to use. If you are sure the disk or
device is present, reboot your system and try again. If it still is a problem, see a repair technician. 
Make sure of the drive or device you are trying to use.

Unknown Disk Type! You are trying to use a diskette that your system does not recognize. Such as trying 
to use a 1.2M floppy on a 360k system. Or trying to use a diskette from another computer system 
that uses another operating system.
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GLOSSARY OF ASTROLOGICAL TERMS
Affliction. An outdated term that describes either a difficult aspect (i.e. Squared or Opposition), or a 

placement of a planet or angle in a sign that does not suit it, (i.e. Mars in Pisces). Also describes a 
relationship with a "Malefic", such as Saturn.

Air Signs. Aquarius, Gemini, or Libra. These signs are generally associated with air. The air signs are 
usually connected with communication and the intellect.

Angles. Refers to the Major angles in a chart. Includes: the Ascendant or Rising Sign, the Descendant, 
which is opposite the Ascendant, the Coeli or Midheaven, and Immum Coeli, which is opposite 
the Coeli.

Angular Houses. The first, fourth, seventh, and tenth houses. These houses are generally connected with 
the Cardinal signs and Cardinal Qualities.

Ascendant. The point of the zodiac that falls on the eastern horizon at the time of your birth. This is the 
same as the first house cusp and describes your personality and character and how you relate to 
your world.

Aspect. An angular relationship between two planets, angles, etc. These relationships are based on 
harmonics or multiples. The major aspects are Conjunct, Trine, Sextile Squared, and Opposition, 
though there are many intermediate minor aspects. The first three aspects are generally considered 
to be beneficial and the last two considered to be difficult, though the more difficult aspects can 
act as teachers and help you to learn and grow.

Astrologer. A professional who practices astrology.
Benefic. Planets and aspects that were thought to give positive influences. Traditionally Jupiter and Venus 

are the two Major Benefics in that order, though Mercury and the Moon are also considered 
Benefic. Conjunct, Sextile, and Trine aspects are also considered Benefic.

Cadent. The third, sixth, ninth and twelfth houses. These are ruled by Mutable Signs, and are generally 
associated with the Mutable Qualities.

Campanus. Thirteenth century mathematician and astrologer who devised the Campanus House System.
Cardinal Signs. The signs Aries, Cancer, Libra and Capricorn. These fall at the Cardinal Points of the 

Zodiac, with Aries beginning at the "Vernal Equinox" or first point of Spring, or the beginning of 
the Zodiac. These signs are generally associated with action and beginnings. They are also 
associated with initiatory and dynamic actions.

Conjunction. An aspect formed when two angles or planets are at roughly the same angle (usually within 8
degrees).

Critical degrees. 13, and 26 degrees of Aries, Cancer, Libra and Capricorn. 9, and 21 degrees in Taurus, 
Leo, Scorpio and Aquarius. Also 4 and 17 degrees in Gemini, Virgo, Sagittarius, and Pisces. 
Comes from the Hindus. Thought to be a sensitive point that strengthens the power of the sign.

Cusp. A line dividing the houses or signs. When dealing with signs it represents a gray area where the 
individual may be affected by both signs.

Decan, Decanates. A division of the signs into 10 degrees each of which is subtly different from one 
another due to the different rulers involved.

Descendant. The angle that is exactly across from the Ascendant. It is the cusp of the seventh house. Your 
descendant relates to your marriage and partnership and interaction with others. 

Earth Signs. The signs Taurus, Virgo and Capricorn. These signs represent "Earthly" qualities such as 
stability, responsibility, and practicality.

East Point. The angle which is rising over the eastern horizon at the earth's equator at any time. 
Occasionally used for Compatibility analysis.

Easy Aspect. A harmonious aspect such as Conjunct, Trine, or Sextile.
Ecliptic. The apparent path that the sun would take if it actually rotated around the earth.
Elements. Air, Water, Earth and Fire.
Equal House System. The system that takes the first house being the Ascendant and dividing the 

remaining 11 houses into equal 30 degree slices. The M-House system starts with the Coeli or 
Midheaven being the cusp of the 10th house and dividing the other 11 houses as equal 30 degree 
slices.
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Feminine Signs. Earth and water signs. Feminine refers to receptivity, not gender.
Fire Signs. Aries, Leo, and Sagittarius. These signs are considered fiery, passionate, and spontaneous.
Fixed Signs. Taurus, Leo, Scorpio, and Aquarius. These signs are associated with fixed and stable 

emotional characteristics.
Flat Chart. A chart in which the first house is set at degrees Aries. Frequently used when the birth time and

therefore the Ascendant is not known.
Greater Benefic. Jupiter. Assumed to bring your major blessings.
Greater Malefic. Saturn. Assumed to be the cause of evil in your life.
Hard Aspects. Inharmonious aspects. Generally considered to be Squared, and Opposition, and others. 

Aspects when the energies do not always help.
Harmonious Aspects. Conjunct, Sextile, and Trine. Also referred to as Easy aspects.
House. A section of the zodiac, mathematically defined, which represents a particular area of life.
Immum Coeli. The bottom of the heavens. The fourth house cusp in non-equal or Quadrant house system. 

Represents The family relations and home life.
Intercepted Sign. A sign that falls between two adjacent house cusps, but neither of those house cusps are 

in that sign.
Koch. Dr. Walter Koch, a German astrologer who founded the Koch House System or Birthplace House 

System.
Locality Chart. See Relocation Chart.
Malefic. An old term used to refer to planets or aspects thought to cause harm. It usually refers to the planet

Saturn and Mars. Minor Malefics are also Uranus, Neptune and Pluto.
Masculine Signs. Air and Fire Signs. Those signs are suggested to manifest aggressiveness, sometimes 

referred to as Positive signs.
Medium Coeli, Med. Coeli, MC. The Midheaven. Taken to be the point directly overhead in the chart. In 

an unequal chart it is the cusp of the tenth house. This describes your career and public ambitions 
and your relations with superiors.

Mutable Signs. The Signs Gemini, Virgo, Sagittarius, and Pisces. Signs associated with adaptability and 
flexibility.

Node. The point of interception between a planet's orbit and the ecliptic.
Opposition. An aspect representing an angular difference of 180 degrees or a situation where two planets 

are directly across a chart from each other. Generally causes difficulty and discord.
Orb. The difference between an exact aspect and the actual aspect. It also describes the maximum 

difference where an aspect still takes place.
Part of Fortune. Arabian part most commonly used by astrologers. Found by subtracting Sun's position 

from the sum of Ascendant and Moon positions in degrees. Suggests fortunate circumstances.
Placidus. Spanish Monk, Placidus de Tito, 17th century. Creator of the Placidus House System. Most 

commonly used house system today.
Planet. From Greek "Planetes" or the wanderer. Describes any body that appears, from the Earth, to move.
Progressions. Term used for advancing planets and house cusps from birth to a second point in time. 

Usually 1 day for each year of life.
Rectification. Correction for inexact birth-time.
Regiomontanus. German Astrologer 15th century who devised the Regiomontanus House System.
Relative Houses. Houses 3, 7, and 11. Associated with the Air Signs.
Relocation Chart. A Chart for which the house cusps have been changed to be where they would be if the 

individual had been born in another location. See Locality Chart.
Retrograde Motion. Apparent Backward Motion, thought to cause difficulty in a person's chart.
Return Chart. A Chart which shows the time that a particular body returns to the position where it was 

when you were born.
Rising Sign. Another word for Ascendant.
Sextile. An aspect with a difference of 60 degrees. A generally helpful and 'Positive' aspect.
Sidereal Time. Time in relation to the fixed stars, rather than clock time.
Sidereal Zodiac. A zodiac based on the placement of the stars, not the Vernal Equinox. It is used in 

Eastern, Hindu or Verdic Astrology.
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Signs. Division of the zodiac into twelve equal divisions, related to the constellations.
Square. Aspect with a difference of 90 degrees. Generally causes difficulty and discord.
Succedent Houses. Houses 2, 5, 8 and 11. Associated with the Fixed Signs.
Temporal Houses. Houses 2, 6, 10. Usually associated with the Earth Signs.
Terminal Houses. Houses 4, 8, and 12. Associated with the Water Signs.
Transit. Aspects or angles between, the position on any given day and the positions on a person's birth 

chart.
Trine. An aspect with a difference of 120 degrees. A generally helpful and positive aspect.
Tropical Zodiac. Zodiac that follows the path of the Sun. The First point of Aries corresponds to the Vernal

Equinox, not an actual star position. Also called a Philosophical zodiac
Vertex. A point in the Western section of the Zodiac that indicates the intersection of the Prime Vertical and

the Ecliptic. Sometimes associated with fate and wish fulfillment.
Water Signs. Signs Cancer, Scorpio, and Pisces. Signs which represent receptivity, sensitivity, and the 

emotions.
Zodiac. From the Greek Zodiakos, meaning circle of animals, or zoo.
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